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Chapter 144

Equivalence Tests for
the Ratio of Two
Within-Subject
Variances in a 2×2M
Replicated CrossOver Design
Introduction
This procedure calculates power and sample size of equivalence (or biosimilarity) tests of within-subject
variabilities from a 2×2M replicated cross-over design. This routine deals with the case in which the statistical
hypotheses are expressed in terms of the ratio of the within-subject variances.
This design is used to compare two treatments which are administered to subjects in different orders. It has two
treatment sequences. Here, M is the number of times a particular treatment is received by a subject. For example, if
M = 2, the design is a 2×4 cross-over. The two sequences would often be
sequence 1: R T R T
sequence 2: T R T R
It is assumed that either there is no carry-over from one measurement to the next, or there is an ample washout
period between measurements.
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Technical Details
This procedure uses the formulation given in Chow, Shao, Wang, and Lokhnygina (2018).
Suppose 𝑥𝑥𝑖𝑖𝑖𝑖𝑖𝑖𝑖𝑖 is the response in the ith sequence (i = 1, 2), jth subject (j = 1, …, Ni), kth treatment (k = T, C), and lth
replicate (l = 1, ..., M). The mixed effect model analyzed in this procedure is
𝑥𝑥𝑖𝑖𝑖𝑖𝑖𝑖𝑖𝑖 = 𝜇𝜇𝑘𝑘 + 𝛾𝛾𝑖𝑖𝑖𝑖𝑖𝑖 + 𝑆𝑆𝑖𝑖𝑖𝑖𝑖𝑖 + 𝑒𝑒𝑖𝑖𝑗𝑗𝑘𝑘𝑙𝑙

where 𝜇𝜇𝑘𝑘 is the kth treatment effect, 𝛾𝛾𝑖𝑖𝑖𝑖𝑖𝑖 is the fixed effect of the lth replicate on treatment k in the ith sequence, 𝑆𝑆𝑖𝑖𝑖𝑖1
and 𝑆𝑆𝑖𝑖𝑖𝑖2 are random effects of the ijth subject, and 𝑒𝑒𝑖𝑖𝑖𝑖𝑖𝑖𝑖𝑖 is the within-subject error term which is normally distributed
2
.
with mean 0 and variance 𝑉𝑉𝑘𝑘 = 𝜎𝜎𝑊𝑊𝑊𝑊
Unbiased estimators of these variances are found after applying an orthogonal transformation matrix P to the x’s as
follows
𝑧𝑧𝑖𝑖𝑖𝑖𝑖𝑖 = 𝑃𝑃′𝑥𝑥𝑖𝑖𝑖𝑖𝑖𝑖

2
.
where P is an m × m matrix such that 𝑃𝑃′𝑃𝑃 is diagonal and var�𝑧𝑧𝑖𝑖𝑖𝑖𝑖𝑖𝑖𝑖 � = 𝜎𝜎𝑊𝑊𝑊𝑊

For example, in a 2×4 cross-over design the z’s become
𝑥𝑥𝑖𝑖𝑖𝑖𝑖𝑖1 + 𝑥𝑥𝑖𝑖𝑖𝑖𝑖𝑖2
= 𝑥𝑥̅𝑖𝑖𝑖𝑖𝑖𝑖 .
𝑧𝑧𝑖𝑖𝑖𝑖𝑖𝑖1 =
2
and
𝑧𝑧𝑖𝑖𝑖𝑖𝑖𝑖2 =

𝑥𝑥𝑖𝑖𝑖𝑖𝑖𝑖1 + 𝑥𝑥𝑖𝑖𝑖𝑖𝑖𝑖2

In this case, the within-subject variances are estimated as

√2

2

= 𝑥𝑥̅𝑖𝑖𝑖𝑖𝑖𝑖 .

𝑁𝑁𝑖𝑖

𝑀𝑀

1
2
� � ��𝑧𝑧𝑖𝑖𝑖𝑖𝑖𝑖𝑖𝑖 − 𝑧𝑧̅𝑖𝑖.𝑇𝑇𝑇𝑇 �
𝑉𝑉�𝑇𝑇 =
(𝑁𝑁1 + 𝑁𝑁2 − 2)(𝑀𝑀 − 1)
𝑖𝑖=1 𝑗𝑗=1 𝑙𝑙=1

and

2

𝑁𝑁𝑖𝑖

𝑀𝑀

1
2
𝑉𝑉�𝐶𝐶 =
� � ��𝑧𝑧𝑖𝑖𝑖𝑖𝑖𝑖𝑖𝑖 − 𝑧𝑧̅𝑖𝑖.𝐶𝐶𝐶𝐶 �
(𝑁𝑁1 + 𝑁𝑁2 − 2)(𝑀𝑀 − 1)
𝑖𝑖=1 𝑗𝑗=1 𝑙𝑙=1

Testing Equivalence
The following hypotheses are usually used to test for equivalence
𝜎𝜎²ᴡᴛ
𝜎𝜎²ᴡᴛ
𝜎𝜎²ᴡᴛ
≥ 𝑅𝑅𝑅𝑅 or
≤ 𝑅𝑅𝑅𝑅 versus 𝐻𝐻1 : 𝑅𝑅𝑅𝑅 <
< 𝑅𝑅𝑅𝑅,
𝜎𝜎²ᴡᴄ
𝜎𝜎²ᴡᴄ
𝜎𝜎²ᴡᴄ
where RL and RU are the equivalence limits.
𝐻𝐻0 :

These hypotheses can be tested using the two one-sided hypotheses

and

𝐻𝐻01 :

𝜎𝜎²ᴡᴛ
𝜎𝜎²ᴡᴛ
≥ 𝑅𝑅𝑅𝑅 versus 𝐻𝐻11 :
< 𝑅𝑅𝑅𝑅
𝜎𝜎²ᴡᴄ
𝜎𝜎²ᴡᴄ

𝐻𝐻02 :

𝜎𝜎²ᴡᴛ
𝜎𝜎²ᴡᴛ
≤ 𝑅𝑅𝑅𝑅 versus 𝐻𝐻12 :
> 𝑅𝑅𝑅𝑅
𝜎𝜎²ᴡᴄ
𝜎𝜎²ᴡᴄ
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The corresponding test statistics are 𝑇𝑇1 = 𝑅𝑅𝑅𝑅 (𝑉𝑉�1 /𝑉𝑉�2 ) and 𝑇𝑇2 = 𝑅𝑅𝐿𝐿 (𝑉𝑉�1 /𝑉𝑉�2 ). Upon making the usual normality
assumptions, these T’s are distributed as 𝐹𝐹𝑑𝑑 ,𝑑𝑑 random variables where
𝑑𝑑 = (𝑁𝑁1 + 𝑁𝑁2 − 2)(𝑀𝑀 − 1).

Power
The power of this combination of tests is given by
𝑅𝑅𝑅𝑅
𝑅𝑅𝑅𝑅
Power = P �
𝐹𝐹1−𝛼𝛼,𝑑𝑑,𝑑𝑑 < 𝐹𝐹 <
𝐹𝐹
�
𝑅𝑅1
𝑅𝑅1 𝛼𝛼,𝑑𝑑,𝑑𝑑

where F is the common F distribution with the indicated degrees of freedom, 𝛼𝛼 is the significance level, and R1 is
the value of the variance ratio stated by the alternative hypothesis. Lower quantiles of F are used in the equation.
A simple binary search algorithm can be applied to this power function to obtain an estimate of the necessary
sample size.

Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For
more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
The Design tab contains the parameters associated with this test such as sample sizes, alpha, and power.

Solve For
Solve For
This option specifies the parameter to be solved for from the other parameters. Under most situations, you will
select either Power or Sample Size.

Power and Alpha
Power
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis
and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null
hypothesis is not rejected. In this procedure, a type-II error occurs when you fail to reject the null hypothesis of
nonequivalent means when in fact the means are equivalent.
Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now,
0.90 (Beta = 0.10) is also commonly used.
A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.
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Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true
null hypothesis is rejected. In this procedure, a type-I error occurs when you reject the null hypothesis of nonequivalent means when in fact the means are nonequivalent.
Values must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means that
about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that represents
the risk of a type-I error you are willing to take in your experimental situation.
You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.

Sample Size (When Solving for Sample Size)
Sequence Allocation
Select the option that describes the constraints on N1 or N2 or both.
The options are
•

Equal (N1 = N2)
This selection is used when you wish to have equal sample sizes in each sequence. Since you are solving for
both sample sizes at once, no additional sample size parameters need to be entered.

•

Enter N2, solve for N1
Select this option when you wish to fix N2 at some value (or values), and then solve only for N1. Please note
that for some values of N2, there may not be a value of N1 that is large enough to obtain the desired power.

•

Enter R = N2/N1, solve for N1 and N2
For this choice, you set a value for the ratio of N2 to N1, and then PASS determines the needed N1 and N2,
with this ratio, to obtain the desired power. An equivalent representation of the ratio, R, is
N2 = R * N1.

•

Enter percentage in Sequence 1, solve for N1 and N2
For this choice, you set a value for the percentage of the total sample size that is in Sequence 1, and then
PASS determines the needed N1 and N2 with this percentage to obtain the desired power.

N2 (Sample Size, Sequence 2)
This option is displayed if Sequence Allocation = “Enter N2, solve for N1”
N2 is the number of items or individuals sampled from the Sequence 2 population.
N2 must be ≥ 2. You can enter a single value or a series of values.
R (Sequence Sample Size Ratio)
This option is displayed only if Sequence Allocation = “Enter R = N2/N1, solve for N1 and N2.”
R is the ratio of N2 to N1. That is,
R = N2 / N1.
Use this value to fix the ratio of N2 to N1 while solving for N1 and N2. Only sample size combinations with this
ratio are considered.
N2 is related to N1 by the formula:
N2 = [R × N1],
where the value [Y] is the next integer ≥ Y.
144-4
© NCSS, LLC. All Rights Reserved.

PASS Sample Size Software

NCSS.com

Equivalence Tests for the Ratio of Two Within-Subject Variances in a 2×2M Replicated Cross-Over Design

For example, setting R = 2.0 results in a Sequence 2 sample size that is double the sample size in Sequence 1 (e.g.,
N1 = 10 and N2 = 20, or N1 = 50 and N2 = 100).
R must be greater than 0. If R < 1, then N2 will be less than N1; if R > 1, then N2 will be greater than N1. You can
enter a single or a series of values.
Percent in Sequence 1
This option is displayed only if Sequence Allocation = “Enter percentage in Sequence 1, solve for N1 and N2.”
Use this value to fix the percentage of the total sample size allocated to Sequence 1 while solving for N1 and N2.
Only sample size combinations with this Sequence 1 percentage are considered. Small variations from the
specified percentage may occur due to the discrete nature of sample sizes.
The Percent in Sequence 1 must be greater than 0 and less than 100. You can enter a single or a series of values.

Sample Size (When Not Solving for Sample Size)
Sequence Allocation
Select the option that describes how individuals in the study will be allocated to Sequence 1 and to Sequence 2.
The options are
•

Equal (N1 = N2)
This selection is used when you wish to have equal sample sizes in each sequence. A single per sequence
sample size will be entered.

•

Enter N1 and N2 individually
This choice permits you to enter different values for N1 and N2.

•

Enter N1 and R, where N2 = R * N1
Choose this option to specify a value (or values) for N1, and obtain N2 as a ratio (multiple) of N1.

•

Enter total sample size and percentage in Sequence 1
Choose this option to specify a value (or values) for the total sample size (N), obtain N1 as a percentage of N,
and then N2 as N - N1.

Sample Size Per Sequence
This option is displayed only if Sequence Allocation = “Equal (N1 = N2).”
The Sample Size Per Sequence is the number of items or individuals sampled. Since the sample sizes are the same
in each sequence, this value is the value for N1, and also the value for N2.
The Sample Size Per Sequence must be ≥ 2. You can enter a single value or a series of values.
N1 (Sample Size, Sequence 1)
This option is displayed if Sequence Allocation = “Enter N1 and N2 individually” or “Enter N1 and R, where N2
= R * N1.”
N1 is the number of items or individuals sampled from the Sequence 1 population.
N1 must be ≥ 2. You can enter a single value or a series of values.
N2 (Sample Size, Sequence 2)
This option is displayed only if Sequence Allocation = “Enter N1 and N2 individually.”
N2 is the number of items or individuals sampled from the Sequence 2 population.
N2 must be ≥ 2. You can enter a single value or a series of values.
144-5
© NCSS, LLC. All Rights Reserved.

PASS Sample Size Software

NCSS.com

Equivalence Tests for the Ratio of Two Within-Subject Variances in a 2×2M Replicated Cross-Over Design

R (Sequence Sample Size Ratio)
This option is displayed only if Sequence Allocation = “Enter N1 and R, where N2 = R * N1.”
R is the ratio of N2 to N1. That is,
R = N2/N1
Use this value to obtain N2 as a multiple (or proportion) of N1.
N2 is calculated from N1 using the formula:
N2=[R x N1],
where the value [Y] is the next integer ≥ Y.
For example, setting R = 2.0 results in a Sequence 2 sample size that is double the sample size in Sequence 1.
R must be greater than 0. If R < 1, then N2 will be less than N1; if R > 1, then N2 will be greater than N1. You can
enter a single value or a series of values.
Total Sample Size (N)
This option is displayed only if Sequence Allocation = “Enter total sample size and percentage in Sequence 1.”
This is the total sample size, or the sum of the two sequence sample sizes. This value, along with the percentage
of the total sample size in Sequence 1, implicitly defines N1 and N2.
The total sample size must be greater than one, but practically, must be greater than 3, since each sequence sample
size needs to be at least 4.
You can enter a single value or a series of values.
Percent in Sequence 1
This option is displayed only if Sequence Allocation = “Enter total sample size and percentage in Sequence 1.”
This value fixes the percentage of the total sample size allocated to Sequence 1. Small variations from the
specified percentage may occur due to the discrete nature of sample sizes.
The Percent in Sequence 1 must be greater than 0 and less than 100. You can enter a single value or a series of
values.
M (Number of Replicates)
Enter one or more values for M: the number of replicates in a 2 × 2M replicated cross-over design. M is the
number of times each treatment is measured on each subject.
For example, M = 2 refers to a 2 × 4 replicated cross-over design. The two sequences used for this design are
often
Sequence 1: R T R T
Sequence 2: T R T R.
You can enter a single value such as 2, a series of values such as 2 3 4, or 2 to 8 by 1.
The range is M ≥ 2.
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Effect Size
RU (Upper Equivalence Limit)
Enter one or more values for the upper equivalence limit for the ratio of the two within-subject variances. When
the ratio of the sample variances is between this value and RL, the two groups are said to have "equivalent"
variances.
This value must be greater than one. Popular choices are 1.5 and 2.
Note
If you enter "1/RL", then 1/RL will be calculated and used for RU. This choice is popular because RL and
RU=1/RL results in limits that are of equal magnitude on the log scale.
RL (Lower Equivalence Limit)
Enter one or more values for the lower equivalence limit for the ratio of the two within-subject variances. When
the ratio of the sample variances is between this value and RU, the two groups are said to have "equivalent"
variances.
This value must be less than one. Popular choices are 0.5 and 0.67.
If you enter "1/RU", then 1/RU will be calculated and used for RL. This choice is popular because RU and
RL=1/RU results in limits that are of equal magnitude on the log scale.
R1 (Actual Variance Ratio)
Enter one or more values for within-subject variance ratio assumed by the alternative hypothesis. This is the value
of σ²ᴡᴛ / σ²ᴡᴄ at which the power is calculated.
This value should be between the two equivalence limits. Hence, RL < R1 < RU.
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Example 1 – Finding Sample Size
A company has developed a generic drug for treating rheumatism and wants to show that it is equivalent to the
standard drug with respect to the within-subject variance. A 2 x 4 cross-over design will be used to test the
equivalence of the two drugs.
Company researchers set the upper limit of equivalence to 1.5, the lower limit to 1/1.5, the significance level to
0.05, the power to 0.90, M to 2, and the actual variance ratio values between 0.8 and 1.3. They want to investigate
the range of required sample size values assuming that the two group sample sizes are equal.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Equivalence Tests for the Ratio of Two Within-Subj Variances in a 2×2M Rep. CrossOver Design procedure. You may then make the appropriate entries as listed below, or open Example 1 by going
to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size
Power ...................................................... 0.90
Alpha ....................................................... 0.05
Sequence Allocation ............................... Equal (N1 = N2)
M (Number of Replicates) ....................... 2
RU (Upper Equivalence Limit) ................ 1.5
RL (Lower Equivalence Limit) ................. 1/RU
R1 (Actual Variance Ratio) ..................... 0.8 0.9 1 1.1 1.2 1.3

Annotated Output
Click the Calculate button to perform the calculations and generate the following output.
Numeric Results ────────────────────────────────────────────────────────────

Actual
Power
0.9002
0.9001
0.9022
0.9012
0.9004
0.9000

Sequence 1
Sample
Size
N1
517
192
134
181
346
838

Sequence 2
Sample
Size
N2
517
192
134
181
346
838

N
1034
384
268
362
692
1676

Number of
Replicates
M
2
2
2
2
2
2

Lower
Equiv
Limit
Variance
Ratio
RL
0.667
0.667
0.667
0.667
0.667
0.667

Upper
Equiv
Limit
Variance
Ratio
RU
1.500
1.500
1.500
1.500
1.500
1.500

Actual
Variance
Ratio
R1
0.800
0.900
1.000
1.100
1.200
1.300

Alpha
0.050
0.050
0.050
0.050
0.050
0.050

References
Chow, S.C., Shao, J., Wang, H., and Lokhnygina, Y. 2018. Sample Size Calculations in Clinical Research, Third
Edition. Taylor & Francis/CRC. Boca Raton, Florida.
Chow, S.C. and Liu, J.P. 2014. Design and Analysis of Clinical Trials, Third Edition. John Wiley & Sons.
Hoboken, New Jersey.
Chow, S.C. 2014. Biosimilars Design and Analysis of Follow-on Biologics, Third Edition. Taylor & Francis/CRC.
Boca Raton, Florida.

144-8
© NCSS, LLC. All Rights Reserved.

PASS Sample Size Software

NCSS.com

Equivalence Tests for the Ratio of Two Within-Subject Variances in a 2×2M Replicated Cross-Over Design
Report Definitions
Actual Power is the actual power achieved. Because N1 and N2 are discrete, this value is usually slightly
larger than the target power.
N1 is the number of subjects from sequence 1.
N2 is the number of subjects from sequence 2.
N is the total number of subjects. N = N1 + N2.
M is the number of replicates. That is, it is the number of times a treatment measurement is repeated on a
subject.
RL is the lower equivalence (similarity) limit for the within-subject variance ratio.
RU is the upper equivalence (similarity) limit for the within-subject variance ratio.
R1 is the value of the within-subject variance ratio at which the power is calculated.
Alpha is the probability of rejecting a true null hypothesis, H0.
Summary Statements ─────────────────────────────────────────────────────────
A 2x2M cross-over design is being used to assess the equivalence of the within-subject
variability of two groups by looking at the ratio of their variances. If the sample variance
ratio falls between two equivalence limits, the groups are concluded to be 'equivalent'.
Otherwise, they are not. Sequence sample sizes of 517 and 517 achieve 90% power to reject the
null hypothesis of non-equivalence at a significance level of 0.050. The lower equivalence
limit is 0.667. The upper equivalence limit is 1.500. The within-subject variance ratio at
which the power is calculated is 0.800. The number of times each treatment measurement is
repeated on a subject is 2..

This report gives the sample sizes for the indicated scenarios.

Plot Section

This plot shows the relationship between sample size and R1.
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Example 2 – Validation using Hand Calculations
We could not find an example in the literature, so we will present hand calculations to validate this procedure.
Set N1 to 100, the upper limit of equivalence to 1.5, the lower limit to 1/1.5, the significance level to 0.05, M to 2,
and the actual variance ratio values 1.0. Compute the power.
The calculations proceed as follows.
Power = P �

𝑅𝑅𝑅𝑅
𝑅𝑅𝑅𝑅
𝐹𝐹1−𝛼𝛼,𝑑𝑑,𝑑𝑑 < 𝐹𝐹 <
𝐹𝐹
�
𝑅𝑅1 𝛼𝛼,𝑑𝑑,𝑑𝑑
𝑅𝑅1

= P �0.666667/1 �𝐹𝐹0.95,198,198 � < 𝐹𝐹 < 1.5/1 �𝐹𝐹0.05,198,198 ��
= P�0.666667(1.26408895) < 𝐹𝐹 < 1.5(0.79108357)�
= P(0.84272639 < 𝐹𝐹 < 1.18662536)
= 0.88524837 − 0.11475232

= 0.77049605

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Equivalence Tests for the Ratio of Two Within-Subj Variances in a 2×2M Rep. CrossOver Design procedure. You may then make the appropriate entries as listed below, or open Example 2 by going
to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Power
Alpha ....................................................... 0.05
Sequence Allocation ............................... Equal (N1 = N2)
Sample Size Per Sequence .................... 100
M (Number of Replicates) ....................... 2
RU (Upper Equivalence Limit) ................ 1.5
RL (Lower Equivalence Limit) ................. 1/RU
R1 (Actual Variance Ratio) ..................... 1.0

Output
Click the Calculate button to perform the calculations and generate the following output.
Numeric Results ────────────────────────────────────────────────────────────

Power
0.7705

Sequence 1
Sample
Size
N1
100

Sequence 2
Sample
Size
N2
100

N
200

Number of
Replicates
M
2

Lower
Equiv
Limit
Variance
Ratio
RL
0.667

Upper
Equiv
Limit
Variance
Ratio
RU
1.500

Actual
Variance
Ratio
R1
1.000

Alpha
0.050

The power matches the hand-calculated result.
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